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Glossary 

This glossary contains definitions specifically related to listed options.  Options 
carry a high level of risk and are not suitable for all investors. Certain requirements 
must be met to trade options through Schwab.  Multiple leg options strategies will 
involve multiple commissions. With long options, investors may lose 100% of funds 
invested.  Spread trading must be done in a margin account.  Please read the 
Options Disclosure Document titled "Characteristics and Risks of Standardized 
Options" before considering any option transaction. Call your local Schwab office or 
write Charles Schwab & Co., Inc. 101 Montgomery Street, San Francisco, CA  
94104 for a current copy. Charles Schwab & Co.,Inc. is a SIPC member. 

Please contact a tax advisor for the tax implications involved in the options 
strategies referenced. 

 

 

Above the Market  

A limit order to buy or sell a security for a specified price that is higher than the 
current market price. A sell order may be placed above the market in an attempt to 
sell at higher prices. However, if the market does not reach these prices, the order 
will go unfilled.  

Above the Money 

For straddles and collars, strike prices of the call and the put are above the current 
price of the underlying security.  

Advance-Decline (AD) Line  

The Advance-Decline (AD) line is the cumulative total for the difference between 
the number of advancing stocks and the number of declining stocks in a given 
market. The AD line for the New York Stock Exchange (NYSE) is the most widely 
used measure of market breadth. If there are more advances than declines, the AD 
is a positive number; if there are more declines, the AD number is negative. That 
daily number is added to the cumulative AD line. The AD line gives us information 
on whether the majority of stocks are following the trend of the commonly followed 
stock indices.  

All Money 

In reference to Advanced Options, all pairings for the specified strike range, 
excluding leaps. 

All or None (AON)  

An All or None (AON) order directs the broker to attempt to fill the entire amount of 
an order or none of it during the time limit specified. AON orders do not require 
immediate execution, and are only applicable to limit orders.  

American Depository Receipt  

ADRs are securities issued by commercial banks that represent the shares of a 
foreign company. Generally speaking, a foreign company will deposit a certain 
amount of shares with a US commercial bank. The bank will then issue a security 
based on a specific number of shares. ADRs trade just like domestic stocks on 
various US stock exchanges, however investors are subject to additional risks, 
including but not limited to currency fluctuation. Their performance usually parallels 
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that of the parent company on its domestic exchange. ADRs offer international 
companies greater exposure and investors the chance to invest in well-known 
foreign companies.  

Arbitrage  

The simultaneous buying and selling of the same or closely related securities, in 
different markets to take advantage of price disparities. Arbitrage attempts to 
realize a profit with minimal to no risk, but generally transaction fees and market 
inefficiencies will substantially minimize profitability for the retail investor.  

Around the Money 

For strangles and collars, strike prices of the call and put lie on opposite sides of 
the current price of the underlying security.  

Ask  

The ask price is the displayed price at which a market maker or specialist offers to 
sell a stock.  

At the Money 

An option is at-the-money if the strike price of the option equals the market price 
of the underlying security. 

 

 

Bar Chart  

In a bar chart, each time period is represented by a vertical bar that represents the 
range between the high and low prices. A bar chart displays more information than 
a line chart, which only shows the closing price for each period. Some variations on 
the standard bar chart are the following: HL (only the high and low price for each 
time period), HLC (the high, low, and close), and OHLC (open, high, low, and 
close).  

Bear Trap  

A bear trap occurs when prices break below a significant level and generate a sell 
signal (q.v.), but then reverse course and negate the sell signal, thus trapping the 
bears that acted on the signal with losses.  

Below the Market  

A limit order to buy or sell a security for a specific price that is lower than the 
current market price. Buy orders may be placed below the bid in an attempt to 
purchase at lower prices. However, if the market does not reach these prices, the 
order will go unfilled.  

Below the Money 

For straddles and collars, strike prices of the call and the put are below the current 
price of the underlying security. 

Beta  

Beta is a measure of the security's systematic or market risk. The level of the beta 
indicates the degree of correlation between a security and a market benchmark, 
usually the S&P 500. The market is the benchmark and has a beta of 1. A beta 
greater than 1 is more volatile than the overall market, while a beta less than 1 
indicates that the security's price is more stable than the market (in general and 
over a long time period).  

Bid  
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The bid price is the displayed price at which a market maker or specialist offers to 
buy a stock.  

Black Scholes Option Pricing Model  

A model used to forecast the price of an option.  

Blue Chip  

A common stock of an established company that has a long record of earnings, 
dividends, stability and high credit quality.  

Bollinger Bands  

Developed by John Bollinger, Bollinger Bands are indicators that allow for a 
comparison of volatility and relative price levels over a period time. This indicator 
consists of three bands designed to encompass the majority of a security's price 
action:     

1. An upper band   

2. A lower band   

3. A moving average     

The time period used for the moving average can vary, but John Bollinger 
recommends 10 days for short term trading, 20 days for intermediate trading, and 
50 days for long term trading.    The upper and lower bands are plotted as standard 
deviation levels -- typically two standard deviations---- above and below the 
moving average. Since standard deviation is a measure of volatility, the bands are 
self-adjusting. They typically widen during volatile markets and contract during 
calmer markets.     

The basic interpretation of Bollinger Bands suggests that prices tend to stay within 
the upper- and lower-bands. The distinctive characteristic of Bollinger Bands is that 
the spacing between the bands varies based on the volatility of the prices. During 
periods of extreme price changes (or high volatility), the bands tend to widen to 
become more forgiving. During periods of stagnant pricing (or low volatility), the 
bands tend to narrow to contain prices. When prices break through a band, this 
may indicate that the move is strong enough to continue further.  

Boxed Position  

Where the security is held in the account both as a long and a short position. These 
positions can be of equal or unequal quantities (i.e. full or partial box).  

Bull Trap  

A bull trap occurs when prices break above a significant level and generate a buy 
signal, but suddenly reverse course and negate the buy signal, thus trapping the 
bulls that acted on the signal with losses.  

Buy  

Purchase of a security.  

Buy Signal  

A buy signal is a condition that suggests a time to buy a stock. The signal will vary 
depending on the type of technical indicator used, or it may be based on a non-
technical event, such as a change in an analyst recommendations or the release of 
positive news. Note: It's unwise to base buy or sell decisions on just one indicator.  

Buy Stop  

A buy stop is a buy order usually placed above the current price, requiring that a 
security would have to trade at or above a set level before the buy order would be 
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activated. For example, an order could be entered at 35.5 for a security trading just 
below resistance at 35. By placing a buy stop order just above resistance, the 
trader prefers to wait for that security to break resistance before going long. This 
type of order can also be used as a stop loss for a short position. Please note that 
there is no guarantee that execution will be at or near your stop price.  

Buy to Close  

You "close" a short option position when you buy it back.  

Buy to Open  

You "open" a long position when you buy a new option.  

Buying Power  

This is the maximum dollar value of marginable securities that you can buy in your 
margin account without depositing additional equity. Buying power is calculated at 
the close of business each day and may fluctuate throughout the day.  

 

 

Call Option  

An option contract that gives the holder the right, but not the obligation, to buy 
100 shares of the underlying security at a fixed price before a specified expiration 
date. Call buyers hope the price of the underlying security will rise. Call sellers hope 
the price will stay the same or go down.  

Candlestick Chart  

A candlestick chart is similar to a bar chart. The major difference is the graphical 
depiction of each period in a "candlestick." Each candlestick is formed using the 
open, high, low, and close of a specific time period. The period can be anything 
from a minute to a month. The color of the candlestick is determined by the 
relationship between the open and close. If the close is higher than the open, a 
white (or green) real body is formed. If the close is lower than the open, a black (or 
red) real body is formed. If the close and open are the same, it will be a cross. The 
thin lines above and below the real bodies represent the high and the low for the 
period and are referred to as shadows. The high for the period is the upper shadow 
and the low is the lower shadow. It is these shadows, which look like wicks on a 
candle, that give rise to the term "candlestick."  

Capital Gain  

The difference in value between what you originally paid for an investment and the 
price at which you sold, assuming the investment gained in value.  

Cash Account  

This type of brokerage account requires that you pay for trades in full by the 
settlement date.  

Cash Secured Equity Put (CSEP) 

A CSEP consists of any number of short uncovered put options written at a strike 
price lower than the stock's price, and where the investor must maintain cash or 
cash equivalents in his account equal to the total amount of the potential 
assignment in the event the put expires in the money, or is exercised by the owner 
of the put.  

Channel  
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A channel refers to the area on a price chart between two parallel trend lines that 
connect the highs and the lows of a prevailing trend.  

Charting  

The set of techniques used in technical analysis in which charts are used to plot 
price movements, volume, and other indicators.  

Close  

The price at which a security closed for trading on a given day.  

Common Stock  

Common stock is "ownership" of a corporation. An owner of a company's common 
stock is considered to have an equity position in the corporate structure of that 
company.  

Confirmation  

Confirmation is a subsequent signal that validates a position stance. Traders and 
investors sometimes look for more than one signal or require validation before 
acting. For example: confirmation of a trend change may entail an advance past 
the previous reaction high. For an indicator such as MACD, confirmation of a 
divergence may be a subsequent moving average crossover. (Not to be confused 
with a trade confirmation, which verifies that a trade order has been executed.)  

Congestion Area  

At a minimum, a series of trading days in which there is no or little progress in 
price.  

Correction  

After an advance, a decline that does not penetrate the low from which the advance 
began is known as a correction. A correction, also referred to as a retracement, 
usually retraces 1/3 to 2/3 of the previous advance.  

Crossed Market  

When the bid is higher than the lowest current offer or vice versa.  

Crossover  

A crossover is a place on a graph where two lines intersect. Depending on what 
each line represents, a crossover may indicate a buy or sell signal. One common 
method of interpreting a moving average is to compare its relationship to the price 
itself. Changes in a market's price trend are not necessarily identified by a reversal 
in the direction of the moving average line, but by the price line crossing through 
the moving average line. It may be considered bearish when price crosses below a 
moving average, and bullish when price crosses above it. Multiple moving average 
crossovers (or "double crossovers") can also be employed through the use of two 
moving average lines -- one of a shorter time span and the other of a longer time 
span. It may be considered bearish when the shorter moving average crosses 
below the longer moving average, and bullish when the shorter crosses above the 
longer. This technique of using two moving averages together typically lags the 
market a bit more than a single moving average.  

Cup and Handle  

A pattern on a bar chart. The pattern can be as short as several weeks and as long 
as a year. The cup is in the shape of a 'U', and the handle has a slight downward 
drift.  

Cyclical Stocks  
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Cyclical stocks are shares of companies with businesses that are highly sensitive to 
economic performance. Cyclical stocks tend to perform well under certain economic 
conditions and suffer during others.  

 

 

Daily Range  

The difference between the high and low during one trading day.  

Day Order  

An order condition that causes your order to be canceled at the end of the current 
day's trading if the order has not been executed. All Market Orders are 
automatically Day orders. Orders are generally considered to be day orders unless 
otherwise specified.  

Day Trading  

Day trading is a style of trading where positions are both initiated and closed before 
the end of the trading day. Compare this to position trading, where stocks or 
securities may be held for longer periods.  

Derivative Instrument  

A financial instrument or security whose value is based in part upon another 
security. For example, a stock option is a derivative instrument because its market 
value is based in part upon the market value of the underlying stock.  

Dilution  

Effect on earnings per share and book value per share from any increase in shares 
outstanding.  

Direct Access  

Schwab's integrated set of trading tools designed to support direct access trading. 
StreetSmart Pro Direct Access provides Level II information into a trading interface 
that gives you control over the routing, targeting, and timing of your order. This 
platform is for experienced traders who are comfortable learning to use advanced 
trading technology to trade NASDAQ securities.  

Direct Access Trading  

A trading method in which traders have control over the routing and targeting of 
their orders. Direct access enables eligible clients to route orders for execution to 
the market centers of their choice. Depending on the brokerage firm, clients may 
be allowed to direct orders to a variety of ECNs, market makers, and exchanges. In 
direct access trading, there are no intermediaries who can safeguard against poor 
trading decisions or serve as buffers between traders and sudden changes in 
market conditions.  

Discretion 

Allows you to have a displayed price and a discretionary price. You can place the 
order at the price you’d like to receive with a discretion amount for the 
maximum/minimum amount you’re willing to pay. Available for limit orders only.  

EXAMPLE A limit order to buy with a displayed price of 50 and a discretionary price 
of 50.25 is presented as:  
Price = 50 
Discretion = 0.25 

Divergence  
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Divergence means that different technical indicators or indices are failing to confirm 
each other. This can be viewed as a warning signal that the prevailing trend may be 
about to reverse.  

Dividend Amount  

Value of last quarterly cash dividend or the number of shares an investor receives 
for each share owned in a stock dividend.  

Dividends Reinvestment  

The application of cash dividends from an equity security to purchase more shares 
of the security.  

Do Not Reduce (DNR)  

Instructs the broker not to reduce the limit price by the amount of the cash 
dividend when a stock goes ex-dividend and the market price is reduced by the 
amount of the dividend. You can specify DNR on limit orders to buy, stop orders to 
sell, or on stop-limit orders to sell.  

Double Tops and Bottoms  

Generally considered to be reversal patterns, double tops or bottoms show as two 
prominent peaks or troughs on the price chart. The first peak or valley is typically 
formed on relatively high trade volume, and the second on relatively low volume. 
The reversal is considered complete when the middle peak (in the case of a double 
bottom) or trough (in the case of a double peak) is broken.  

Dow Jones Industrial Average (DJIA)  

Published by Dow Jones & Co, the Dow Jones Industrial Average (DJIA) is a price-
weighted average of 30 blue-chip stocks. Because it is price weighted, stocks with 
the highest prices will have the most influence and those with the lowest, the least 
influence. The DJIA is calculated by adding the closing prices of the 30 stocks, and 
then dividing by a number that takes into account splits, large dividends, 
substitutions and mergers. The component stocks of the DJIA have changed over 
the years to reflect the composition of the U.S. economy.  

Dual Listed Stocks 

Stocks listed on the New York Stock Exchange that are eligible for trading via 
SuperMontage, a routing venue normally only available to NASDAQ stocks, in 
addition to the NYSE and some ECNs. 

 

 

Earnings Per Share Date  

Date of the last earnings announcement.  

Electronic Communication Network (ECN)  

An Electronic Communication Network (ECN) is a computerized trading system that 
facilitates trading between two parties without a market maker or specialist as an 
intermediary. If an ECN cannot match an order, it usually either sends the order to 
another ECN or market maker or posts the order to the order book until a matching 
order is found. ECNs are identified in the software as follows:  [INET] NASDAQ  
[EDGA] EdgeTrade [BTRD] Bloomberg  [BRUT] NASDAQ  [ARCA] NYSE Arca  
[ONTD] OnTrade 

Electronic Funds Transfer  

Transferring funds between accounts and firms electronically.  
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Elliot Wave Theory  

Originally published by Ralph Nelson Elliot in 1939, Elliot Wave Theory is a pattern 
recognition theory that is based on repetitive wave patterns and the Fibonacci 
number sequence. An ideal Elliott wave pattern holds that a five wave advance is 
followed by a three wave decline to form a complete cycle.  

Ex-Dividend Date  

Date a stock or cash dividend is reflected in the price of the security (if you buy a 
stock on the ex-dividend date, you are not entitled to the dividend); for stock 
dividends, this is the trading day after the distribution is made.  

Excercise Price (or Strike Price) 

See Strike Price. 

Expiration  

The date an option contract becomes void. All holders of options must indicate their 
desire to exercise by this date.  

Fed Call  

Also known as Regulation T or Reg T Call. This type of call occurs when establishing 
a margin position. Investors must deposit initial margin (typically 50%) of the cost 
of the trade per current Federal Reserve requirements.  

Fibonacci Fan Lines  

Fibonacci Fan lines are based on the Fibonacci number series and combine two 
additional analytical concepts--trend line and percentage retracement. Fibonacci 
Fan lines are typically drawn at 38%, 50%, and 62% angles from prominent price 
peak and troughs. Theoretically, these fan lines may then provide support during 
subsequent downward corrections, and resistance during subsequent upward 
advances.  

Fibonacci Retracements  

Fibonacci Retracements are based on the Fibonacci number series and represent 
price movements in the opposite direction of the previous trend. Retracements can 
be calculated by drawing a trendline between a prominent price peak and trough, 
then forming horizontal lines at the 38%, 50%, and 62% levels of retracement 
from the prior price move. Theoretically, as prices retrace, the retracement levels 
may act as support or resistance.  

Fill or Kill (FOK)  

A Fill or Kill (FOK) order instructs the broker to immediately fill an order in its 
entirety or to cancel it. FOK instructions are only applicable to limit orders.  

Freeriding  

This trading violation is the result of buying a security in your Cash Account and 
then selling the same security without making separate payment on the full 
purchase price by Settlement Date. This situation is called freeriding because 
basically it is unauthorized borrowing to pay for a trade.  

Fundamental Analysis  

Fundamental analysis is the study of economic, industry, and company conditions 
in an effort to determine the value of a company's stock. Fundamental analysis 
typically focuses on key statistics in a company's financial statements to determine 
if the stock price is correctly valued.  
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Gaps  

Gaps form when opening price movements create a blank spot on the chart. Gaps 
may be especially significant when accompanied by an increase in volume. An up 
gap forms when a security opens above the previous period's high, remains above 
the previous high for the entire period and closes above it. Up gaps can form on 
daily, weekly or monthly charts and are generally considered bullish. A down gap 
forms when a security opens below the previous period's low, remains below the 
previous low for the entire period and closes below it. Down gaps can form on daily, 
weekly or monthly charts and are generally considered bearish.  

Good Til Canceled (GTC)  

Instructs the broker to keep an order open until it is either executed or expires. At 
Schwab, GTC orders remain open for 60 calendar days unless filled or you request 
that it be canceled before that time.  

Halted Securities  

Occasionally, trading on a given security may be suspended due to a variety of 
conditions, including news and corporate actions. If the security you are attempting 
to trade has been halted, you can place an order but it will not be eligible for 
execution or in force until the trading halt is lifted. If you have an open order for a 
security that subsequently is halted, your order will be eligible for execution after 
the halt is has been lifted. Please be aware that when the security resumes trading 
it may be at a price significantly above or below the most recent trade price.  

Head and Shoulders  

The Head and Shoulders pattern is one of the best known of the reversal patterns. 
At a market top, three prominent peaks are formed with the middle peak (or head) 
slightly higher than the two other peaks (shoulders). When the trend line (neckline) 
connecting the two intervening troughs is broken, the pattern is complete. A 
bottom pattern is a mirror image of a top and is called an Inverse Head and 
Shoulders.   

Immediate or Cancel (IOC)  

Requires the broker to immediately fill as much of the order as possible and then 
cancel any remaining portion. (It may not be available in all market conditions.) 
Unlike All or None (AON) or Fill or Kill (FOK) instructions, IOC orders may result in a 
partial execution. Immediate or Cancel can be entered with either market or limit 
orders.  

Implied Volatility  

Implied volatility is a key variable in most option pricing models, including the 
Black-Scholes Option Pricing Model. Other variables usually include security price, 
strike price, risk-free rate of return, and days to expiration. If all other variables 
are equal, the security with the highest volatility will generally have the highest 
option prices.  

In the Money 

For a call option to be in-the-money, an option's strike price must be below the 
market price of the underlying security. For a put option, in-the-money is when the 
strike price is above the market price of the underlying security. 

Indicator  

An indicator is a value, usually derived from a stock's price or volume, that an 
investor can use to try to anticipate future price movements. Indicators are divided 
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into two groups: trend following (or lagging) and momentum (or leading). Lagging 
indicators tell you what prices are doing now, or in the recent past, so are useful 
when stocks are trending. A moving average is an example of a lagging indicator. 
Leading indicators are designed to anticipate future price action and many come in 
the form of oscillators. RSI is an example of a momentum indicator.  

Inside Day  

An Inside Day represents a day in which the total range of price is within the 
previous day's price range.  

Inside Market  

The highest bid and lowest ask prices among all competing market makers in a 
NASDAQ security.  

Invisible (INV)  

An order that is deemed "Invisible" or "Subscriber only" will not display on the ISLD 
order book. These orders will be matched, if possible, but an invisible order has less 
priority than other orders. If an order with a restriction is entered before an 
unrestricted order at the same price; the unrestricted order will execute first. 
Invisible and Subscriber Only orders do not comply with the Display Alternative as 
described in the SEC Order Handling Rules. They are bad for price discovery.  

 

 

Last Split Date  

The last date on which the shares of a security were increased or decreased by 
splitting.  

Last Trade  

The price at which the last trade was executed; after market close, this is the 
closing price.  

Last Trade Date and Time  

The date and time the security was last traded.  

Level I  

A quote for a security that displays the current best Bid and Ask prices, volume, 
close price from the previous trading day, open price, high and low price for the 
day, and perhaps the ratio of shares or market participants at the inside Bid and 
Ask.  

Level II  

Level II is a display of both Level I quotes and bid and ask quotes from all quoting 
market participants (market makers and ECNs) at lower and higher prices than the 
best bid and ask.  

Level III  

Consists of Level II Service plus the ability to enter quotations, direct/execute 
orders, and send information; this service is restricted to NASD member firms that 
function as registered Market Makers in either NASDAQ, exchange-listed, or OTC 
Bulletin Board securities.  

Limit Order  

An order to buy or sell a security at a specific price. As opposed to a market order, 
limit orders might not be filled quickly or at all if the market moves away from the 
specified price. A limit order guarantees price, but not execution.  
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Line Chart  

The line chart is a price chart that simply connects the closing prices for a given 
market over a specified period of time, resulting in a curving line on the chart.  

Liquidity  

The ability of a stock to be readily bought or sold without causing significant price 
fluctuations. Generally, the greater the number of buyers and sellers of a particular 
stock, the more liquid the stock.  

Locking the Market  

Market condition in which there are identical bid and ask prices for a stock.  

Look-back Period  

The look-back period is the number of periods (minutes, days, weeks, months) 
used to calculate an indicator. For example, a 14-day RSI would have a look-back 
period of 14 days.  

 

 

Maintenance Call  

A "call" for additional funds or acceptable collateral to be immediately deposited 
into your margin account. This type of margin call is generated when the equity in a 
margin account does not meet an established minimum requirement. This can be 
caused by fluctuations in market prices or your additional use of margin.  

Margin Account  

This type of brokerage account allows you to borrow funds, using your own 
marginable securities as collateral. The borrowed funds may be used for the 
purchase of more securities.  

Margin Balance  

The net open balance in your margin account. If negative, this is the amount owed 
to the brokerage firm. If positive, the balance is available to earn interest.  

Margin Call  

This term refers to both maintenance calls and "Regulation T" calls (also called Reg 
T or Fed calls). An investor who receives a margin call is required to deposit 
additional funds or securities in a margin account either because the equity in the 
account does not meet an established minimum equity requirement (maintenance 
call) or because additional securities have been purchased or sold short.  

Margin Interest  

Margin interest is charged daily based on your margin balance.  

Marginable  

A security that may be used as collateral in a margin account. Most listed securities 
trading at over $5 per share are marginable, as are most fixed income securities, 
OTC stocks, and open ended mutual funds (30-days after they have been fully paid 
for). To find out if a specific stock is marginable, please contact a Schwab 
representative.  

Market Capitalization  

Market Capitalization, or market cap, is the total market value of a company 
(number of shares outstanding multiplied by the price of the stock). For example, a 
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company with 1 million shares outstanding and a stock price of $10 would have a 
market capitalization of $10 million.  

Market Indicators  

A variety of indices and other data that indicates the overall direction and strength 
of the market.  

Market Maker  

Market makers are the dealers in the NASDAQ market. They provide liquidity to the 
market by trading for their customers or for their own accounts, and are committed 
to buy and sell shares in the stock in which they make a market. Market makers 
display their buying and selling interest in the Level II quotes.  

Market Order  

An order to buy or sell a security at the prevailing market price. Sometimes 
referred to as "at the market." A market order guarantees execution, but not price.  

Market Peg 

Pegs the order price to the ask if buying or to the bid if selling, meaning the order 
price will automatically adjust as the bid or ask moves until the order executes or 
the stock trades beyond your limit price. Orders may be adjusted a penny up or 
down to avoid locking the market.  

EXAMPLE 

• XYZ is currently quoted at 20 bid x 20.05 ask.   

• A Market Peg order to buy XYZ with a limit of 20.10, will be submitted at 
20.05.  

• If the quote changes to 20.05 bid x 20.10 ask, the order price would change 
to 20.10.  

• If the order is not executed, it will not update beyond the limit price and will 
remain posted at 20.10. 

Max Floor 

Specifies the reserve size for the order. Must be a round lot equal to or less than 
the order quantity. Reserve size has no time priority in Level II. Only the displayed 
portion of the order will have time priority. 
EXAMPLE  You enter a bid with 5,000 as the total quantity, but 1,000 as the Max 
Floor value. Your order will display as 1,000 shares, but if yours is the only bid 
when an offer arrives for 10,000 shares at your price, your entire 5,000 shares will 
execute.  

However, if 3 other bids for 3,000 shares each were behind you at the same price, 
only your displayed 1,000 would execute, along with 9,000 shares from the other 
three bids. 

Minimum Acceptable Quantity (MAQ)  

Instructs the broker to fill a minimum share amount of an order.  

Minimum Quantity  

Instructions to buy or sell a specified number of shares at a limit price, with the 
condition that the first fill must be for a minimum number of shares.  

Momentum  

Momentum is an overbought/oversold indicator that measures the velocity of price 
changes for a set period of time. Momentum is measured by continually calculating 
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price differences between the most recent price and the price n-periods ago, then 
plotting these differences around a centerline.    If the latest price is greater than 
the first price, a positive value is plotted above the centerline. If the latest price is 
below the first price, a negative value is plotted below the centerline. The greater 
the change in prices, the greater the change in Momentum.     

If prices are rising and the momentum line is above the centerline and rising, an up 
trend may be accelerating. When the Momentum line drops below the centerline, a 
near-term downtrend may be in effect. One popular time period used for 
Momentum is the 10-day, however any time period can be employed. A shorter 
time period produces a more sensitive line with more pronounced oscillations 
(extremes), while a longer period results in a smoother line with less volatile 
swings.  

Money Flow & Money Flow Percentage  

Developed by Marc Chaikin, Money Flow is one of several indicators available to 
measure the flow of money in and out of a particular security. The Money Flow 
indicator is derived from the daily read of the Accumulation/Distribution Line.    The 
basic premise behind the Accumulation Distribution Line is that the degree of 
buying or selling pressure can be determined by the location of the close relative to 
the high and low for the corresponding period ("closing location value").     

The closing location value multiplied by volume forms the Accumulation/Distribution 
Value for each period. Money Flow Percent is calculated by dividing the sum of the 
daily Accumulation/Distribution values over a specified time period by the sum of 
the Volume over the corresponding period.     

Generally, accumulation or buying pressure is present when prices close in the 
upper half of the day's range, and distribution or selling pressure is evident when 
prices close in the lower half of the day's range. If prices consistently close in the 
upper half of their daily high/low range on increased volume, then the indicator will 
be positive and display above the zero line; this indicates that the market may be 
strong.     

Conversely, if prices consistently close in the lower half of their daily high/low 
range on increased volume, the indicator will be negative and display below the 
zero line; this indicates that the market may be weak.     

It should be noted that because the change from close to close is not considered in 
the calculation, a security can close lower and still exhibit signs of accumulation, or 
close higher and still exhibit signs of distribution.  

Moving Averages  

Moving averages are one of the more versatile and widely used of all technical 
indicators. A moving average shows the average value of a security's price over a 
specified period of time.     

To get the average to "move," a new item of price data is added while at the same 
time the oldest item is removed. By using an average of prices, moving averages 
are able to smooth a data series and make it easier to identify any underlying 
trend.     

Essentially a trend-following indicator, the moving average works best in markets 
that are trending -- as opposed to markets in trading ranges. They are used to 
identify and confirm trends, as well as identify support and resistance areas.  

It's also important to note that shorter-term averages are typically more sensitive 
to individual price fluctuations, while longer-term averages are less sensitive.     
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Moving Averages include:  Simple Moving Average (SMA) - The simple moving 
average is the most widely used moving average and is constructed by simply 
totaling a set of price data and dividing the sum by the number of observations. 
SMAs give equal weight to each price data input.   Exponential Moving Average 
(EMA) - The exponential moving average is similar to the SMA, only it uses a 
"smoothing factor" to give more weight to recent prices while at the same time 
allowing all price data to influence the average. By putting more weight on recent 
price data, the EMA reduces the time lag and reacts more quickly to recent price 
changes.    

Moving Average Convergence/Divergence (MACD)  

The Moving Average Convergence/Divergence is a trend following momentum 
indicator that shows the relationship between two moving averages. The MACD line 
is calculated by taking the difference between a longer-period and shorter-period 
moving average (typically 26-day and 12-day respectively). It is the interaction of 
these two moving averages that gives the indicator its name, as over time the two 
are constantly converging and diverging. A signal line is also used, which is 
typically the 9-period moving average of the MACD line. Exponential moving 
averages are typically used for both the MACD and Signal calculations because they 
tend to respond more quickly to changes in price.   

Moving Average Convergence/Divergence Histogram (MACD Histogram)  

A variation of the MACD that plots the difference between the signal line and MACD 
line. Changes in the spread between these two lines may be spotted faster using 
the histogram display, potentially leading to earlier trading signals.  

Multiplier  

The premium is multiplied by the multiplier multiplied by the number of contracts to 
determine the actual cost of an option purchase.  The multiplier is 100 in the case 
of standardized options for both equity and index options; however, stock splits can 
change the multiplier.  The multiplier is the number of shares that an equity option 
will convert to if exercised.  

 

 

NASDAQ  

Formerly known as the National Association of Securities Dealers Automated 
Quotations system, designed to facilitate over-the-counter stock trading. The 
NASDAQ is now an exchange and is no longer an acronym.  

NASDAQ Composite Index  

The NASDAQ Composite Index is a market capitalization-weighted index of over 
5000 stocks. Because it is weighted by market capitalization, large companies such 
as Microsoft, Intel, WorldCom, Sun Microsystems, Dell Computer and Oracle 
dominate the index. With such large portion of the index dominated by technology 
stocks, the NASDAQ Composite is more a barometer for the technology sector than 
the broader market.  

NASDAQ National Market (NNM)  

Consists of More than 3,900 companies that are the larger and generally more 
actively-traded NASDAQ securities.   

National Best Bid or Offer (NBBO)  

NBBO represents the bid and ask price that will display in Level I.  
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Negative Divergence  

When two or more indicators, indexes, or averages, fail to show confirming trends.  

Net Change  

The amount and direction of a security's price change since its previous close.   

Odd Lot  

An amount of stock consisting of less than 100 shares.  

Offer  

See 'Ask'  

On Balance Volume (OBV)  

Introduced by Joe Granville in 1963, On Balance Volume (OBV) is a momentum 
indicator that relates volume to price change. On Balance Volume shows if volume 
is flowing into or out of a security. When the security closes higher than the 
previous close, all of the day's volume is considered "up" volume. When the 
security closes lower than the previous close, all of the day's volume is considered 
"down" volume.  

Open  

The price at which a security opened for trading on a given day.  

Option  

A contract that gives the buyer the right, but not the obligation, to buy or sell a 
particular asset (the underlying security) at a fixed price for a specific period of 
time.  This contract also obligates the seller to meet the delivery terms if the buyer 
exercises the contract right.  The owner of call option has the right to purchase the 
underlying asset at a specific price, and this right lasts until a specific date.  The 
owner of a put option has the right to sell the underlying asset at a specific price, 
and this right lasts until a specific date. Clients may also take specialized positions, 
such as spreads, straddles, and/or combinations, depending on the level of trading 
for which they are approved.  

Out of the Money 

A call is out of the money when an option’s strike price is higher than the market 
price of the underlying security. A put is out of the money when the strike price is 
below the market price of the underlying security. 

Outed  

A term used by traders to confirm that an order was canceled by the Market Maker 
or Exchange.  

Over-the-Counter (OTC)  

Over-the-Counter refers to stocks not traded on registered exchanges. Many OTC 
stocks are traded through NASDAQ, OTCBB (Bulletin Board), or the Pink Sheets.  

Overbought  

Overbought is a technical condition described as such by various technical 
indicators that occurs when prices are considered too high and may be susceptible 
to a decline. Overbought conditions can be classified by analyzing the chart pattern 
or with indicators such as the Stochastic Oscillator and Relative Strength Index 
(RSI). A security is sometimes considered overbought when the Stochastic 
Oscillator exceeds 80 and when the Relative Strength Index (RSI) exceeds 70. It is 
important to keep in mind that overbought is not necessarily the same as being 
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bearish. It merely infers that the stock may have risen too far too fast and might 
be due for a pullback.  

Oversold  

Oversold is a technical condition described as such by various indicators when 
prices are considered too low and may be ripe for a rally. Oversold conditions can 
be classified by analyzing the chart pattern or with indicators such as the Stochastic 
Oscillator and Relative Strength Index (RSI). A security is sometimes considered 
oversold when the Stochastic dips below 20 and when the Relative Strength Index 
(RSI) declines below 30. It is important to keep in mind that oversold is not 
necessarily the same as being bullish. It merely infers that the security may have 
fallen too far too fast and may be due for a reaction rally.  

 

 

Pay Date  

The date the shares from a split or dividend are paid to the shareholders.  

Percent Retracement  

The amount that price retreats following a high can be measured using a technique 
referred to as Percent Retracement. This measures the percentage that prices 
"retrace" from the high to the low. For example, if a stock moves from a low of 50 
to a high of 100 and then retraces to 75, the move from 100 to 75 (25 points) 
retraced 50% of the original move from 50 to 100. Measuring the percent 
retracement can be helpful when determining the price levels at which prices will 
reverse and continue upward.  

Position  

Holdings in an account or portfolio.  

Position Trading  

Position trading means holding open positions for an extended period of time. 
Contrast this with day trading, where a trader buys, then sells before the market 
closes that day.  

Preferred Stocks  

A class of stock that pays dividends at a specified rate and has preference over 
common stock in the payment of dividends and the liquidation of assets. Preferred 
stockholders may have different or no voting rights.  

Premium  

The total price of an option’s intrinsic value plus time value. Often (erroneously), 
this word is used to mean the same as time value.  

Price  

See ask price, bid price, and last trade. 

Price/Earnings Ratio  

The price/earnings ratio (P/E ratio) is figured by dividing the price of a stock by the 
company's earnings per share.  

Primary Peg 

Pegs the order price to the bid if buying or the ask if selling OTC securities, or the 
best exchange bid/ask for Listed securities. The order price will automatically adjust 
as the bid or ask moves until the order executes or the stock trades beyond your 
limit price. 
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EXAMPLE 

• XYZ is currently quoting at 20 bid x 20.05 ask.   

• A Primary Peg order to buy XYZ with a limit of 20.05, will be submitted at 20. 

• If the quote changes to 20.05 bid x 20.10 ask, the order price would change 
to 20.05. 

• If the order is not executed, it will not update beyond the limit price and will 
remain posted at 20.05. 

Proxy  

A proxy is a security or index whose correlation with another security or index is so 
strong that it is used as a substitute for the other.  

Put Option  

An option contract that gives the holder the right but not the obligation to sell a 
number of shares of the underlying security at a specified price until the option's 
expiration date. Put buyers hope the price of the underlying security will fall. Puts 
may also be purchased to protect an investment in case the price of the underlying 
security goes down. Put sellers hope the price will stay the same or go up.  

Put/Call Ratio  

Based on CBOE (Chicago Board Options Exchange) statistics, the Put/Call Ratio 
equals the total number of puts divided by the total number of calls. All stock and 
index options traded on the CBOE are included in the calculation. Typically, there 
are more calls traded than puts, so the ratio is usually below 1. When more puts 
are traded than calls, the ratio will exceed 1. As an indicator, the Put/Call Ratio 
may be used to measure market sentiment.  

Quantity  

The number of shares you want to buy, sell, or sell short.   

 

 

Rate of Change  

The Rate of Change (percent) is a momentum oscillator that measures the percent 
change in price from one period to the next. The Rate of Change is plotted as an 
oscillator that fluctuates above and below a zero line.  

Reaction  

A temporary price reversal within the prevailing trend.  

Regulation T Call  

Also called a Fed Call, this is the amount an investor must deposit if buying on 
margin or selling short, as required by the Federal Reserve Board's Regulation T. 
Current Federal Reserve requirements are 50% of the cost of the trade.  

Relative Strength  

A comparison of an individual stock's performance to that of a market index. Most 
times the S&P 500 or the Dow Jones Industrial Average are used for comparison 
purposes. A rising line indicates that the stock is doing better than the market. A 
declining line indicates that the stock is not doing as well as the market.  

Relative Strength Index (RSI)  

Developed by J. Welles Wilder in 1978, the Relative Strength Index is one of the 
more popular momentum indicators. Its name, Relative Strength Index, is slightly 
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misleading, as it does not compare the relative strength of two securities, but 
rather the internal strength of a single security.      

The RSI is a price-following oscillator that ranges between 0 and 100. Wilder 
argues that the RSI usually tops above 70 and bottoms below 30, and that these 
tops and bottoms usually form before the underlying price changes direction. When 
Wilder introduced the RSI, he recommended using a 14-day RSI.     

Since then, the 9-day and 25-day RSIs have also gained popularity. The fewer days 
used to calculate the RSI, the more volatile the indicator. One popular method of 
analyzing the RSI is to look for a divergence in which the security's price is making 
a new high, but the RSI is failing to surpass its previous high. This divergence may 
be interpreted as an impending reversal. If the RSI then turns down and falls below 
its most recent trough, it is said to have completed a "failure swing." The failure 
swing is considered a confirmation of an impending reversal.  

Resistance and Support  

Support is defined as an area on the price chart below the market where buying 
interest appears sufficiently strong to overcome selling pressure.     

Resistance is the opposite of support and represents an area on the price chart 
above the market where selling pressure appears sufficiently strong to overcome 
buying pressure. Generally, support levels are suggested by previous lows, while 
resistance levels are suggested by previous highs.     

Support and resistance areas may be viewed as areas in price movements where 
buying and selling interest is equal. The longer the time span that prices trade in 
these areas, the more significant these areas may become.     

Two other possible indications of significance include:   

-Heavy volume within a support or resistance area.    

-Recent trade activity within a support or resistance area.    

Whenever a support or resistance level is penetrated by a significant amount, the 
two can reverse roles and become the opposite. In other words, if price trades 
significantly through a prior resistance level, this level can become a future support 
level. If price trades significantly through a prior support level, this level can 
become future a resistance level.  

Reversal Pattern  

A reversal pattern implies that the previous trend will be reversed when the pattern 
is complete. For example, after an advance, a reversal pattern marks a change in 
trend from up trend to down trend.  

Rights  

Rights allow existing shareholders of a corporation to subscribe to shares of a new 
issue of common stock before that stock is offered to the public. A right usually has 
a life of 2 to 4 weeks, is transferable, and entitles the holder to buy the new 
common stock below the Public Offering Price. Rights are often granted to protect 
existing shareholders from the effects of dilution.  

Rounding Tops and Bottoms  

Generally considered to be reversal patterns, rounding tops and bottoms are areas 
on the price chart that indicate smooth curvature of prices, rather than distinct 
peaks or troughs. A rounding top displays as a convex shape, sometimes called an 
"inverted bowl," that can precede a new down trend. A rounding bottom displays as 
a concave shape, often called a "bowl" or "saucer," that can precede a new up 
trend. There are currently no measuring formulas associated with these patterns.  
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Sector  

A sector is a group of companies that generate revenue in similar ways, and tend to 
rise and fall at the same time of the economic cycle. Sector investors watch for 
strength or weakness in the various sectors, before making investment decisions. 
The relationship between sector strength or weakness, and the business cycle, is 
called Sector Rotation.  

Security Type  

The type of security such as stock, bond or mutual fund.  

Sell  

Indicates you already own a security and wish to transfer ownership in exchange 
for cash.  

Sell Signal  

A sell signal is a condition that indicates a good time to sell a stock. The exact 
circumstances of the signal will be determined by the indicator that an analyst is 
using. Note: It's unwise to base buy or sell decisions on just one indicator.  

Sell to Close  

A long option position is closed when it is sold. See Option.  

Sell to Open  

A short position opened when a new option is sold. See Option.  

Settlement Date  

The business day by which you must pay for securities purchased or deliver 
securities sold.  

Short Interest  

The number of shares that have been sold short and not yet repurchased.  

Short Sell  

Selling a stock not owned in the hope that the price will go down. The seller must 
indicate that the sale is a short sale when the order is entered. This can only be 
done in a margin account. If available, the stock may be borrowed from a 
brokerage firm for delivery to the buyer and must be bought back at a future date. 
The firm reserves the right to call the security back at any time. Short sales require 
the equity be deposited in a margin account. Short selling is an advanced trading 
strategy involving potentially unlimited risks, and must be done in a margin 
account.  Margin trading increases your level of market risk.  For more information 
please refer to your account agreement and the Margin Risk Disclosure Statement. 

! NOTE:  Short sale orders can be placed as either day or GTC orders; however, 
GTC orders can expose you to substantial risk. Although the stock may be borrowed 
on the day the order is entered, it may not be available for loan on the day the 
order is filled. An immediate buy-in may result for your account.  

Short Sell-Exempt 

A customer service representative may enter Short Sell-Exempt orders on your 
behalf in certain limited circumstances.  The most common instance when this may 
occur is when liquidating the underlying security where the position is held as either 
an equity right, warrant, or convertible. In these circumstances, the securities are 
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not in an acceptable form for delivery on settlement date. Note that you must file 
an exercise for the right, warrant or convertible before your order to liquidate the 
underlying security can be marked as Short Sell-Exempt. This action acknowledges 
that the intent is to sell a position instead of short a stock and is therefore exempt 
from the up-tick rule.  Please see Up-Tick rule for more information. 

Size  

Size represents the number of shares immediately available to buy (bid) or sell 
(ask). For example, a bid of 54 with a size of 500 would indicate an order to buy 
500 shares at 54. By the same token, an ask of 55 with a size of 1000 would 
indicate an order to sell 1000 shares at 55.  

SmartEx  

SmartEx is a trade execution technology that combines the best of intelligent order 
routing (IOR) with market maker liquidity enhancements. SmartEx is designed to 
deliver trade executions that are as good as, if not better than, what you would 
expect to receive using IOR alone.  

Special Conditions  

Special conditions may be applied to an order, such as All or None (AON) or Do Not 
Reduce (DNR).  

Specialist  

An individual, corporation, partnership, or group of firms on a listed exchange floor 
that is responsible for a given exchange-traded security. The specialist stands 
ready to buy and sell shares to maintain an orderly market. A Market Maker serves 
a similar purpose for an OTC security.  

Spread  

The difference between the bid and the ask. Generally speaking, the more liquid 
(trading volume) a stock is, the smaller its bid/ask spread will be. Less liquid stocks 
(those with very light volume) usually have larger spreads.  

Standard and Poors 500 Index (S & P 500)  

The Standard and Poors 500 Index (or S & P 500) lists the 500 largest large-cap 
stocks, that is, stocks from large companies in various industries.  

Stochastic Oscillator  

Stochastics compare where a security's price closed relative to its price range over 
a given time period. The indicator consists of two lines representing the position of 
the market on a percentile basis, with zero at the bottom of the n-day range and 
100 at the top of the range. The main, faster line is called %K, while the second 
line, called %D, is simply a moving average of %K. A stochastic value of 50 
indicates that the last closing price is at the midpoint of the trading range for the 
specified period. Readings above 75% may indicate that the security is overbought, 
while readings below 25% could suggest it is oversold. It is important to note that 
it is not unusual for Stochastics to remain in an overbought/oversold condition for a 
long time period as the security's price continues to climb/fall.  

Generally, a bullish interpretation may be suggested when the %K line crosses 
above the %D line while in oversold territory, and a bearish interpretation may be 
suggested when the %K line crosses below the %D line while in overbought 
territory.  

Stock Dividends  

A dividend paid in stock rather than cash.  
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Stop Limit Order  

An order that becomes a limit order once the security trades at or through the 
designated stop price. A stop limit order instructs a broker to buy or sell at a 
specific price or better, but only after a given stop price has been reached or 
passed. It is a combination of a stop order and a limit order, as such, execution is 
not guaranteed even if the stop price is reached.   

Stop Order  

A market order that is only activated when a print or quote that is at or through the 
stop price. For equity sell-stop orders, the order is activated when the bid is at or 
below the stop price. For equity buy-stop orders, the order is activated when the 
offer is at or above the stop price. For options sell-stop orders, the order is 
activated when the offer is at or below the stop price. For option buy-stop orders, 
the order is activated when the bid is at or above the stop price.  

Once the order is activated, you are guaranteed execution, but there is no 
guarantee of the execution price. Execution may occur either above, at or below 
your stop price. 

Strike Price (or Exercise Price)  

The price at which the owner of an option can purchase (call) or sell (put) the 
underlying security.  

Subscriber  

Subscriber Only orders are identical to normal orders, except that they are not 
included for display in the ISLD quote on NASDAQ. They are visible to anyone with 
access to the Island book and have the same execution priority as unrestricted 
orders. Invisible and Subscriber Only orders do not comply with the Display 
Alternative as described in the SEC Order Handling Rules.    

SuperMontageSM  

SuperMontageSM is NASDAQ's fully integrated order display and execution system.  
SuperMontage was designed to help reduce market fragmentation, provide best 
execution, expand the number of choices to Market Participants, and better handle 
the growth of the market. It is also a voluntary open-access system that is 
intended to increase transparency for investors and market participants by 
displaying market participants' trading interests below a single price level.  The 
order routing and execution segment of SuperMontage replaced SuperSOES and 
SOESSM orders. 

Support  

See "Resistance".  

 

 

Technical Analysis  

The study of market action. It is the representation, usually in graphic form, of the 
actual history of trading (price changes, volume of transactions, etc.) in a certain 
stock or index and then deducing from that pictured history the present position 
and possible future trend.  

Tick  

The tick refers to each individual move from one trade to another in a stock. An up 
tick means the price moved up from the last trade execution, while a down tick 
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means it moved down. If there is no change from the last trade, the tick is 
considered neutral.  

Time and Sales  

Time and Sales reflect the trades occurring in the market by displaying each trade's 
price, size (number of shares), and time that the trade was reported.  

Time Conditions  

The following time limits may be applied to Stop, Limit, or Stop Limit orders: Day 
Only, Good Until Canceled, Fill or Kill, Immediate or Cancel.  

Trailing Stop  

Trailing Stop is a stop order request set at a price level that is above (for short 
positions) or below (for long positions) the current price that adjusts as the price 
fluctuates. For a long position, a trailing stop would be set below the current price 
and rise as the price advances. Should the price decline and reach the trailing stop, 
then a stop order would be triggered and the position closed. As long as the price 
remains above the trailing stop, the position is held.  

Trend  

Trend refers to the direction of prices over time. Rising peaks and troughs 
constitute an up trend, while falling peaks and troughs constitute a down trend. 
Trends are generally classified as major (longer than a year), intermediate (one to 
six months), or minor (less than a month).  

Trend Line  

Trend lines are created by joining significant highs and lows on a price chart. An up 
trend line connects a series of higher lows, while a down trend line connects a 
series of lower highs. An internal trend line can also be drawn to best approximate 
the majority of relative highs or relative lows without any special considerations 
given to extreme price points.  

Triangles  

Triangle patterns are sideways patterns in which price fluctuates within converging 
trend lines. The three types of triangles are the symmetrical, the ascending, and 
the descending. A symmetrical triangle occurs when prices are making both lower-
highs and higher-lows. An ascending triangle occurs when there are higher-lows (as 
with a symmetrical triangle), but the highs are occurring at the same price level 
due to resistance. The odds favor an upside breakout from an ascending triangle. A 
descending triangle occurs when there are lower-highs (as with a symmetrical 
triangle), but the lows are occurring at the same price level due to support. The 
odds favor a downside breakout from a descending triangle. Prices often breakout 
rapidly from a triangle, and the breakout can be confirmed when accompanied by 
an increase in volume.  

 

 

Up-Tick Rule 

The up-tick rule requires that selling short any exchange-listed equity may only be 
done when the last reported sale price is higher than the previous reported sale 
executed at a different price (previous sales at the same price do not count). 
NASDAQ stocks, when executed on NASDAQ, may only be sold short when the 
current bid price is higher than a previous bid.  When a NASDAQ stock trades on an 
exchange there is no up-tick rule applicable unless that exchange implements the 
up-tick rule for NASDAQ stocks.  There is no up-tick rule for OTC Bulletin Board and 
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Pink Sheet stocks. When an order is entitled to an exemption from the up-tick rule, 
that order can be placed as a sell short exempt order—there are limited instances 
where the rules permit the exemption.  Please see Short Sell Exempt for more 
information. 

Volatility  

Volatility is a measurement of change in price over a given period. It is usually 
expressed as a percentage and computed as the annualized standard deviation of 
the percentage change in daily price.  

Volume  

Volume is the number of shares traded in a security over a period of time. On a 
chart, volume is usually represented as a histogram (vertical bars) below the price 
chart.   

Warrants  

A type of security usually issued together with a bond or preferred stock that allows 
the holder to buy a proportionate amount of common stock at a fixed price (usually 
above the market price at the time of issuance) for a period of years or to 
perpetuity. Warrants are transferable and trade on the major exchanges. They are 
also known as Subscription Warrants.  

Whipsaw  

A whipsaw occurs when a buy or sell signal is reversed in a short time. Volatile 
markets and sensitive indicators can cause whipsaws. For example, a whipsaw 
would occur if a position trader initiates a long position on a bullish MACD crossover 
and has to close it the next day because of a bearish moving average crossover.  

Williams %R  

The Williams' %R is a momentum indicator that measures overbought/oversold 
levels. The interpretation of Williams' %R is very similar to that of the %K 
Stochastic Oscillator. Readings in the 80-100 range indicate that a security is 
overbought, while readings in the 0-20 range indicate oversold.  

 

 



Reference 

Copyright © Charles Schwab & Co., Inc. 2006. All rights reserved. (0106-5667) 371 

StreetSmart Pro Training 

Educate yourself on the features and benefits of StreetSmart Pro by taking the 
following tutorials.  

• Quick Start Guide - Learn about StreetSmart Pro’s key features in less than 
10 minutes. This course offers a general overview of StreetSmart Pro and will 
help you quickly acclimate to the trading platform. 

• Trading Window - Learn to submit direct access trades, read Level II and 
Time & Sales displays, and utilize the software settings available in 
StreetSmart Pro. 

• Multi-Leg Options - Learn the types of advanced option strategies available 
in StreetSmart Pro and how to trade them. 

• Account Detail - Learn to actively manage your account by tracking your 
orders, position status, balances, and transaction history. 

• Charts - Learn to create charts that meet your needs by adding overlays, 
technical analysis studies, and trend lines. 

• Watch List - Learn to create customized Watch Lists with access to 
streaming market quotes and news. 

• Alerts and Conditional Commands - Learn to create and submit Alerts 
and Conditional Orders to help protect existing positions and to find new 
trading opportunities. 

• Stock Screener - Learn to find possible trading opportunities with the Stock 
Screener, a powerful platform-based screening and signal generating tool.  

• Sectors Tool - Learn to locate the top performing Sector, Industry, or Sub-
Industry over any one of many time periods to start the Top-Down review for 
investment opportunities. 

• Strategy Tester - Learn how to use historical market data and technical 
analysis to help you make future trading decisions.  

• Strategy Matrix™ - See how to use the Strategy Matrix to monitor technical 
strategies for individual securities or indexes.  

• Strategy Ticker® - Learn to use the Strategy Ticker to continuously scan 
the entire market for securities and indexes that meet pre-defined technical 
analysis parameters. 
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Navigating Online Help 

Answers to your questions about StreetSmart Pro® are at your fingertips. Here’s a 
brief guide to navigating Online Help before you Get Started:  

NEW FEATURES 

The most recent changes to the software.  

TRAINING 

Logon to Schwab.com and click the My Home tab and then the My Benefits 
subtab for information on StreetSmart Pro training.  

CONTENTS TAB 

If your question relates to a specific window or function of the software:  

1. Click on the corresponding chapter in the left-hand navigation panel. 

2. Doing so will display another tier of chapters or topics directly below them. 
Click the one that best describes the type of information you’re looking for.  

FULL-TEXT SEARCH 

If you are looking for information on a specific subject, you may perform a search 
of the help contents by entering the search word or phrase in the upper left corner 
Search field. StreetSmart Pro help uses a natural language search engine to help 
you find the information you need more quickly. 

GLOSSARY, INDEX, ETC. 

These features are located in the Reference tab on the right side of the Help 
window. There, you’ll find:  

• Glossary  

• IDs - includes Market Participant IDs.  

• Comprehensive FAQ’s (Frequently Asked Questions)  

• Printable User Manuals  

• User Agreements  

• Link to Customer Education on Schwab.com  

ABOUT THIS USER MANUAL 

This Educational Guide and its content (including price and volume data, screen 
samples, and queries) are for informational and educational purposes only. 
Although it may provide general information relating to trading or investment 
approaches, you should not construe anything in the guide as legal, tax, and 
investment, financial or other advice. Nothing contained in the guide constitutes a 
solicitation, recommendation, promotion, endorsement, or offer by Schwab of any 
particular security, transaction, or investment strategy. 

Schwab makes no recommendations or endorsements with respect to any of the 
strategies, chart patterns, or indicators referenced; nor does Schwab recommend 
the use of technical analysis as a sole means of investment research. At Schwab, 
we recommend that investors define their goals, risk tolerance, time horizon, and 
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investment objectives in addition to researching possible investment choices 
through multiple channels. Use of technical analysis may result in increased 
frequency of trading and, therefore, significantly higher transaction costs than a 
fundamental approach. CyberTrader, an affiliate of Charles Schwab & Co., Inc., 
provides technical services for StreetSmart Pro, a Schwab product. StreetSmart Pro 
is a registered trademark of Charles Schwab & Co., Inc. Schwab StreetSmart Pro is 
a pending trademark of Charles Schwab & Co., Inc. 

Options carry a high level of risk and are not suitable for all investors. Certain 
requirements must be met to trade options through Schwab. Please read the 
Options Disclosure Document titled "Characteristics and Risks of Standardized 
Options" before considering any option transaction. Call your local Schwab office or 
write Charles Schwab & Co., Inc. 101 Montgomery Street, San Francisco CA 94104 
for a current copy. Access to Electronic Services and your account may be limited 
or unavailable during periods of peak demand, market volatility, systems upgrades 
or maintenance, or for other reasons. 

2006© Charles Schwab & Co., Inc. All rights reserved. Member SIPC. (0704-
10579) 
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Identifiers 

MARKET MAKER, ECN, AND EXCHANGE IDS 

Refer to The NASDAQ Trader Symbol Directory, which provides access to All Issues 
(NASDAQ and Other Exchanges), Mutual Funds, and Market Participants. All 
information is as of the current trading day. However, please refer to the Daily List 
for final verification of daily changes or additions.  
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FAQs 

GETTING STARTED FAQS 

What are the minimum system requirements to run StreetSmart Pro®?   

StreetSmart Pro is designed to work on Windows 95, 98, ME, NT, XP and 2000 
systems with 128 MB RAM and 40 MB of available space on the hard drive. To 
check your RAM:  

1. Click the Start button, then Settings > Control Panel.   

2. In this window, double-click System. This will launch a dialog box displaying 
your installed RAM.  

StreetSmart Pro also requires a connection to the Internet with at least a 56K 
modem. Cable or DSL connection is recommended.   

     

When I try to connect to StreetSmart Pro with Microsoft Internet Explorer, 
I get the error message "Cannot connect to CyberTrader." What should I 
do?  

1. Check to be sure your version of Internet Explorer is equipped with 128-bit 
encryption. You can verify this by opening your browser and clicking on 
Help > About Internet Explorer.  

2. Under the version number, you will see Cipher Strength. If it does not read 
128-bit, click the link Update Information. This will take you to the 
Microsoft website where you can download the latest version.   

3. Once you have 128-bit encryption, try connecting to StreetSmart Pro again.  

If you continue to get the same error message after you have confirmed that your 
version of Internet Explorer has 128-bit encryption, repeat the process and reboot 
your computer.  If that still does not work, contact your Schwab Active Trader team 
and ask to be connected to Technical Support.  

     

Sometimes I see trade restrictions in effect and trade restrictions lifted. 
What is that and why does it hinder my ability to place orders in my 
account?   

You may see a note in your Messages Window stating the following, "trade 
restrictions in effect" and then later a Message Window note stating, "trade 
restrictions lifted". Trade restrictions occur when the balances, positions, and 
transactions (B,P,&T) that are sent from Schwab do not reach and post to 
StreetSmart Pro. As such, the program cannot verify what the BP&T for the account 
currently is, so trading gets restricted. This message has nothing to do with 
restrictions or issues at the account level.   

As this does inhibit trading, you can always logoff and then logon again.  This 
normally will correct the problem and allow for you to be able to do trading.  If this 
is not successful, contact your Schwab Active Trader team.  

     

I got my StreetSmart Pro software from a friend. How do I get set up?   

StreetSmart Pro is offered at no charge to a select group of non-professional 
Schwab Active Trader clients, based upon trading frequency. If you did not receive 
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an email or phone invitation to use StreetSmart Pro, please contact your Schwab 
Active Trader team for assistance.  

     

I qualify for StreetSmart Pro but don’t have the link to download it.   

The StreetSmart Pro download link is located on the Schwab Signature Services 
Research website at the StreetSmart Pro Center on Schwab.com. If you cannot find 
the link, contact your Schwab Active Trader team for help.  

     

How do I trade with StreetSmart Pro?   

Simply open the Trading window and use the Order Entry Panel to place your order. 
For more information about placing an order in the Trading Window, see About the 
Trading Window.   

You may also link to schwab.com for trading: Open a web browser to connect to 
schwab.com for trading.   

     

I have a Macintosh. Can I use StreetSmart Pro?   

No. Currently, there are no plans to create a Macintosh version of StreetSmart Pro. 
However, Mac users can access streaming quotes and news with Schwab’s 
StreetSmart.com web-based platform.  

 

STREETSMART PRO® WINDOWS FAQ 

I do not see any articles in the News window. What’s wrong?   

If you cannot see any news in the News window, it’s possible that there isn’t any 
news for the symbol you are currently viewing since you logged on.  To see if any 
news is out for today, you can right-click in the display window and select Query. 
 Input the symbol you want to query and select the Last 24 Hours radio button, 
and click OK. 

It may also be possible that you are using the same color for your background and 
font. To adjust your colors:  

1. Click on the News window Settings > Colors.  

2. Choose the colors for the background and fonts.  

3. To change the colors, click on the color wheels on the right side of the page 
and select contrasting font and background colors.   

4. If this does not resolve the problem, please contact your Schwab Active 
Trader team.  

     

How can I move the windows around individually and customize the 
layout?  

You can move the windows within StreetSmart Pro by clicking on the window you 
want to move.  Place the cursor on the highlighted title bar, left-click and hold the 
mouse down, then drag the window to the new location and release the mouse. 
 You can also then resize the window by placing your cursor on any corner of the 
window, left-click and hold the mouse down, then move your mouse until the 
window fits where you want it to be displayed and release the mouse.  
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I use several monitors. How can I move the StreetSmart Pro windows to 
display on different monitors?  

Follow the instructions for enabling free-floating windows.   

Once this feature is enabled, you can move different components of StreetSmart 
Pro onto different monitors.  

     

I minimized one of the StreetSmart Pro windows and now I can’t see it. 
How do I get it back?  

From the Main Menu, select Tools > Find Active Tool.   

This will show all the active windows.  

Click on the window you are looking for and it will be displayed on top of the 
window that it was hidden behind.  

     

I cannot see the Tabs on my windows, how do I add them?  

From the menu of Charts, Watch Lists, Top 10 or High/Low, Tabs > Enable.   

This will show two or more tabs in the active windows.  

From the Tabs menu you can also Insert new tabs or Edit existing tabs.  
  

LEVEL II QUOTES FAQ 

Why don’t I have any streaming data in the Level II panel?  

Market Makers and ECNs are only shown when you are viewing a NASDAQ security. 
These will not be shown when you are viewing a Listed security unless you are 
using the Direct ECN quotes. All StreetSmart Pro® users can use the Direct ECN 
quotes, but not all StreetSmart Pro users are eligible for Level II quotes. For more 
information on eligibility for Level II, please contact your Schwab Active Trader 
team.   

To access the Direct ECN quotes, go to Settings > General > L2 Data tab and 
select from the available ECNs. Direct INET and ARCA quotes are normally available 
for any NASDAQ or Listed security.  

TRADING WINDOW FAQ 

What is the Level II showing me in the Trading window?   

The streaming boxes display Level II data, representing the number of shares 
available at a specific price for a specific Market Maker, ECN or exchange. 

From left to right:  

• The first box indicates the bid prices and associated available shares 
currently available for the specified security. Full share amounts are 
displayed.  

• The middle box indicates the ask prices and associated available shares 
currently available for the specified security.  

• The last box, Time & Sales, is a running log of the trades executed for the 
specified security. This shows Time and Sales of the trade as it is reported to 
NASDAQ and not the actual time that the MM traded the stock (90 second 
reporting rule).   
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To learn more about NASDAQ Level II quotes, see the Streetsmart Pro® Trading 
Window Platform course available by clicking on the Education Weblink icon .   

     

How do I view Options in the Trading window?   

1. Enter the underlying stock symbol in the Symbol field and press Enter.  

2. Choose the Options tab in the Trading window.  

3. You can choose to view only calls or puts for the nearest month. You can 
also select a specific month for any options’ cycle.  

     

What does the Ratio represent in the Trading window?   

The left side of the ratio represents the number of shares currently reflecting a bid 
price at the inside bid.   

The right side of the ratio displays the number of shares currently reflecting an ask 
price at the inside ask.   

     

Can I change the way the ratio is displayed?  

You can change this ratio to represent the number of Market Makers available at 
the inside bid/ask prices. Simply:  

1. Click on the Trading window.  

2. Choose Settings > General > L1 Data tab.   

3. In the General window, uncheck the Compute Ratio From Quantities box.  

4. Click OK.  

     

How do I get the symbol I entered in the Trading window to reflect in the 
Charts and News windows?  

StreetSmart Pro® software can link Charts and News to the Trading window. To 
use this feature:  

1. Click Settings > Links. This will open the links menu.   

2. Choose which windows you want to be linked to the Trading window you are 
using.   

3. Clicking on the name will highlight the selection as a new link to the Trading 
window.  

4. To remove a link, clicking on the highlighted name will deactivate the link.  

     

The Order Entry panel has disappeared from my Trading window. What 
happened?   

You can open and close the Order Entry panel of the Trading window by clicking the 
arrow under Last (Trade Price).  

     

Will clicking an action button automatically submit my order?   

You willl receive an Order Verification to review before submitting your order if you 
have left the Order Verification setting checked (located under Settings > 
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General > Orders). If you uncheck this box, which is not recommended, your 
orders will be submitted without any chance to review.   

For SmartEx orders, if you checked the Spec Cond checkbox, a pop-up window will 
open allowing you to designate additional order qualifiers before you verify or 
submit your order.  

     

Is there a faster way to submit SmartEx Day Market and Day Limit orders? 
  

Yes. You can submit Day Market and Day Limit orders directly from the Trading 
window by not checking the Spec Cond checkbox. Spec Cond is not an alternative 
when submitting Direct Access orders.  

     

Why do I see Direct Access routes for some equities but not others?   

Schwab’s Direct Access trading offer applies to Listed, NASDAQ, and OTC equities 
only. In addition you have the choice to route to any of Schwab’s three daily 
sessions (Pre Market, SmartEx, and After Hours.)   

     

Why do I not see any Level II information?   

Check to make sure that your settings are correct to receive Level II quotes. Go to 
the Trading window and click on Settings > General. If you have been qualified 
for Level II access, you should be able to click on the MM/Exchange Best 
checkbox. If that check box is grayed out, please contact your Streetsmart Pro 
representative. 

 

What are the rules for trading options at Schwab?   

To start trading options at Schwab, you'll need to complete an Option Trading 
Application. Based on a review of the application and your requested strategies, 
Schwab will approve your account to trade at one of the following four levels: 

Level 0: Allows you to write covered calls and buy protective puts.  

Level 1: Allows you to write covered calls, buy calls and puts.  

Level 2: Allows you to write covered calls, buy calls and puts, and create spreads, 
long straddles, and long combinations. 

Level 3: Allows you to buy and sell covered and uncovered calls and puts, and 
create spreads and straddles.  

If you are currently approved for options trading and decide that you would like to 
apply to upgrade your option trading level, please complete a new Option Trading 
Application. Schwab will evaluate your application and send a confirmation of the 
option trading strategy approved for your account.  

! NOTE: Schwab Keogh and Custodian Accounts are only eligible for Level 0 option 
trading and cannot be upgraded to a higher level of option trading.  

 

Can I trade Cash Secured Equity Puts (CSEPs) on StreetSmart Pro? 

You can if your account meets certain requirements: 

• If you have a Level 1, 2, or 3 option approved margin account or a Level 1 
option approved IRA or cash account, AND  
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• If you have sufficient cash in your account to cover the position. 

Cash types that can be used to secure the put: 

• Schwab Value Advantage Funds 

• Cash Deposits 

• Schwab Bank Deposits 

• Schwab Money Market Funds 

Options carry a high level of risk and are not suitable for all investors. Certain 
requirements must be met to trade options through Schwab. Please read the 
Options Disclosure Document titled "Characteristics and Risks of Standardized 
Options" before considering any option transaction. Call your local Schwab office or 
write Charles Schwab & Co., Inc. 101 Montgomery Street, San Francisco, CA 
 94104 for a current copy.    

  

CHARTS FAQ 

How many charts can I see at once?   

StreetSmart Pro® allows six charts to be viewed at once.  

     

How do I compare a stock chart against another symbol or Index?   

In the Chart window menu bar:  

1. Go to Settings > General.   

2. The General window provides an Overlay Symbol option, which allows one 
stock or Index symbol to be entered.   

3. Enter the symbol and click OK.   

4. The chart will now compare your original stock to the symbol you just 
entered.   

5. This symbol will continue to be reflected on all stock charts generated in this 
Chart window until you manually remove the symbol by going to Settings > 
General, deleting the symbol in the Overlay Symbol field, and clicking OK.  

     

How do I change the symbol in the Chart window?   

1. Click on the chart and type a new symbol.  

2. Then press Enter to display the new chart.  

Or you can link the Chart window to the Trading window by going to Settings > 
Links in the Trading window. See the Trading window section for more information.  

     

How do I change the Chart variables?   

Go to the Chart window Menu and choose Settings > General.   

This will allow the chart to be set with the different types of charting styles and 
time frames.   

     

How can I see all of the information regarding my studies in the Info 
window?   
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1. Go to the Chart window Menu and choose View > Info Window to have 
the window displayed on your screen.  

2. Drag your mouse to the Info window until you get to the bottom edge of the 
window and your mouse cursor changes to a double-headed arrow.  

3. Drag the bottom edge of the Info window down to enlarge it. This will 
enlarge the window and allow you to see all of the indications of the studies 
that you are following.  

 

ACCOUNT DETAIL FAQ 

BALANCES 

How do I view the latest marked-to-market balances in my account?  

Balances will update when you first logon and then every 15 minutes or 30 seconds 
after a transaction, whichever comes first.  If you have a Margin account, you can 
find the time of your last update by going to the Balances tab and clicking on the 
Detail button located near your Margin Buying Power.  

     

How accurate are the Balances displayed on the Balances tab?  

Balances are updated in real-time to reflect both security and cash transactions and 
intra-day price movements. Consequently, the cash and security balances and the 
derived figures (such as buying power and margin equity) should all be an accurate 
snapshot of your account at the time that the data is refreshed.  

Your positions are updated on a tick-by-tick basis during market hours.  It is very 
possible that the current values in your Balances tab may not match the Positions 
tab, as the Balances tab is static and the Positions tab is dynamic.  

     

Why are my Balances different on StreetSmart Pro® software than on 
other Schwab electronic channels?   

All Schwab electronic channels are in the process of being converted to using 
marked to market balances and positions. Before this conversion process is 
complete, it is possible that StreetSmart Pro software will be using this real-time 
valuation method while other channels are using methods based on security prices 
from the close of the previous business day.   

Additionally, the StreetSmart Pro quote feed is different than feeds used by other 
electronic channels such as Velocity therefore you may see slight variances based 
on both the quotes themselves as well as the timing of the balance update.  

POSITIONS 

What is meant by "open positions"?   

Securities that hold in your account are "open positions." Once you sell a position 
that you are long or buy back a position that you are short, that position is 
considered closed. This page only displays your open positions.  

 

How are "Market Value" and "Prices" determined?   
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Market Values and Prices displayed are real-time and derived from the real-time 
quotes for the securities in your account.   

 

How is the Cost determined?   

Adding and subtracting the fills received for your positions determines the total 
cost. The cost is calculated by multiplying the number of shares and the execution 
price for each fill. Commissions, Fees and other events such as dividend payments 
and other corporate actions are not included in this calculation.   

As shares/contracts are added to a position the new cost is based on an average 
share/contract price. Liquidations of shares do not impact the average share price. 
This method of calculation is the same as for a Mutual Fund and does not consider 
lot accounting which allows for the management of positions based on FIFO or LIFO 
accounting rules.  

 

What does the asterisk (*) next to the cost figure mean?   

An asterisk indicates that the cost displayed is probably incorrect. When summing 
the executions for your position if the ending position amount differs from the 
position received from the position database it will be marked with an asterisk. 
Please be aware that fill events that occurred prior to January 2004 will not be 
included in the calculation of the cost for your position.   

 

How is the P&L calculated?   

The Cost amount is compared to the Market Value and the difference is the profit or 
loss on your position.  

TRANSACTIONS 

Can I Control the Volume of Transactions sent to me when I Update?   

Yes. The 30-day setting is a default value. Simply click in the Days field and change 
the number to the number of days to want to see. You can set the value anywhere 
in the range of 1 to 30 days. The higher the value, the more days of transaction 
data you will receive and the longer it takes for that information to be transmitted. 
  

   

Can I build up transaction history over a period of time in Streetsmart Pro 
?   

No. Unlike transaction data found on other Schwab channels, data is not stored on 
your Streetsmart Pro desktop. If you want to retain transaction data spanning 
periods greater that the last 30 days, you must export this data for use with an 
external application, such as MS Excel.  

Alternatively, if you need to look further back than the 90-day maximum limit of 
the StreetSmart Pro software, the quickest way is to go to schwab.com or contact 
your Schwab Active Trader Broker. 

 

STOCK SCREENER FAQ 

How can I save my personal Queries?   
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Streetsmart Pro® software will automatically save any personal queries that you 
create. To return to a query that you have created go to User Queries and you will 
see your queries listed in the drop-down. This query will automatically be saved 
when you logoff, but not to a file. As a result, File > Clear the Query File will 
cause the personal query to be lost, if not saved to a file. .  

To save a Query to a file, see Creating and Saving Queries.  

   

The queries that I am creating are not producing the results that I am 
expecting. What am I doing wrong?   

In addition to knowing what the filter variables mean, you must also understand 
how to use them properly to get the output you desire. One way of doing this is to 
screen for a stock that meets your criteria, find the values of the filters you are 
using and then use that information to refine your query. 

For more information about creating user queries, use the Education Weblink 
from the StreetSmart Pro toolbar to access the Stock Screener Platform Course.   

 

Where can I find out what filter variables comprise a built-in query?   

Whether the query you are interested in is Built-In or one of you created, you can 
view the filter variables by selecting the query and then going to View > Query 
Description.   

 

Can I use an existing query as a starting point for a new user query?   

Yes, select the query that you would like to use as your starting point. Then go to 
User Queries > Edit Query. 

! NOTE: You must rename your new query to save it.   

WATCH LIST FAQ 

How do I create a watch list?   

Click on the Watch List icon in the Toolbar. If you want to delete a current watch 
list and create a new one:  

1. From the Watch List window, Click the File > Clear Watch List.  

2. This will empty the current list.   

3. Now you can add symbols one at a time by right-clicking in the Watch List 
window and selecting Add Symbol.   

4. You can set up the entire list at once by clicking on Settings > Symbol 
List. This allows you to add or remove symbols from the list.   

5. You can also use the Insert key on your keyboard to open a pop-up box and 
add symbols or the Delete key for removing symbols.  

6. When you have finished, click OK.   

7. You can save your Watch List by clicking File > Save Watch List As, then 
selecting a Watch List Name.   

 

How do I customize my Watch Lists?   

To customize the column headings in your Watch Lists:  
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1. Right-click on the column you want to change.  

2. From the pull-down menu, select the new value of the by clicking on the 
name.  

3. To adjust the number of columns and headings all at once, click on Settings 
> Columns.   

For a detailed description of each column, see Watch Lists.  

   

How do I add a symbol to my Watch List?   

To add a symbol:  

• Right-click in the Watch List window and select Add Symbol, 

• Press the Insert key on your keyboard, OR  

• From the Watch List window click on Settings > Symbol List.  

   

How do I look up symbols for my Watch List?   

To perform a symbol lookup:  

• From the Main Menu, click Tools > Symbol Lookup.  

• Or click the Symbol Lookup icon in the Toolbar.  

   

How many symbols can I put in a Watch List?   

Each Watch List can display up to 100 symbols, and you can create as many Watch 
Lists as you like. You are only limited to the amount of disk space on your 
computer.   

   

How do I retrieve a Watch List?  

1. Go to the menu bar in the Watch List window and choose File > Load 
Watch List.  

2. Double-click on your preferred Watch List or choose the Open button to 
display the Watch List.  

   

How do I enter options in a Watch List?   

1. Go to the Watch List window.  

2. Click Settings > Symbols List.   

3. Enter a period ( . ) followed by the option symbol, for example .INQFF, or 
enter the option symbol and ".o" as in INQFF.o.  

4. Click OK.   

   

How do I enter an Index in a Watch List?   

1. Go to the Watch List window.  

2. Click Settings > Symbols List.   

3. Enter a $ followed by the Index symbol. See Index Symbols.  

4. Click OK.   
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5. The option symbol will appear in the Watch List window.  

   

How can I tell if I entered a bad symbol?   

If the text in the window reads "Requesting Information for [stock/Index/option 
symbol]" and does not update or you see "Symbol - ?" in the title bar of the 
window, you have entered a bad symbol.   

To find the correct symbol:  

1. Go to the StreetSmart Pro Toolbar and click the Symbol Lookup icon .  

2. Enter the symbol or as much company information as you have.  

3. Click OK.  

 

How do I enter a Preferred or a Stock Class symbol using StreetSmart Pro? 
  

When you are entering a symbol into Trading window, the text will always display 
in uppercase.  For Preferred stocks, you use a Shift+P when entering in the 
symbol will denote that you are requesting a quote for a Preferred stock.  For 
example:  PCGpA  

For a Stock Class quote, you use a (/) to indicate you are requesting a specific class 
of stock.  For example:  TAP/A is for Travelers Class A stock and TAP/B is for 
Travelers Class B stock.  NOTE:  Not all Stock Class stocks use the (/) indicator. 
 For example:  VIA is Viacom Class A, but VIA/B is Viacom Class B. 

For best results, use the Symbol Lookup from the StreetSmart Pro Toolbar . 

 

How do I set up Watch List Groups?   

To establish a new group highlight the line in the watch list where you would like 
the group to be. Using the right click menu select Insert Group. A line will be 
inserted in the watch list and the cursor will appear allowing you to type in the 
name for your Group.  

Adding symbols to a group can be done via two methods.  

• Inserting a symbol to a Group one at a time: Highlight the Group name and 
using the right-click menu select Add Symbol to Group.  

• Inserting several symbols to a Group at one time: Go to Settings > 
Symbol List. Fill in the Symbol field, click on the name of the group you 
wish to add it to, and click Add Symbol to Group.  

! NOTE:  To add symbols into the main Watch List use the Insert Symbol menu 
choice. 

 

TOP TEN FAQ 

How can I see Top Ten information for NASDAQ equities too?   

Clicking on the Top Ten icon in the toolbar will launch information for NYSE stocks. 
Clicking a second time will launch information for NASDAQ stocks.   

   

Why is the Top Ten window empty?   
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This could be happening for the following reasons: 

The connection to the server could be down. You can try to reconnect using the 
Reconnect To Servers function located in the main StreetSmart Pro® toolbar 
under Help. If that is not successful, logoff and back on.  

If you are logged in during the Extended Hours Trading sessions, the window could 
be empty.  

 

How can I reduce the amount of space that the Top Ten windows occupy in 
the display window?  

The Top Ten windows can be formatted in a variety of different ways using data 
you select. These settings are located in the Settings > General window.   

• Determine if you need to see information for both the NASDAQ and NYSE 
markets.  

• Determine if you are really interested in gainers, decliners and volume or if 
a subset of this information is what you find most useful.  

• Determine if you need to see all three data columns.  

• See if formatting horizontally works better in you existing layout.  

 

HIGHS & LOWS FAQ 

Why is the window always empty when I first login or open the window?   

This could be happening for the following reasons: 

• This window populates in a similar manner to the Time & Sales panel in the 
Level II montage and does not display any historic data. As new highs and 
lows are reached the window begin to populate.  

• Because this data stream does not include historic data, if you log in outside 
of market hours it could remain empty.  

• Go to Settings > General to make sure that you have selected the data 
you are interested in viewing.  

   

Why do I hear about stocks hitting new High-Lows but do not see them 
display?   

Check the filter settings in Settings > Filters and change if necessary.  
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Printable User Manuals 

PRINTABLE USER MANUALS 

Download a printable version of the Online Help by clicking the link below. You will 
need the latest version of Adobe Acrobat Reader to view this PDF formatted 
document.  

Printable User Manuals  

• Full Manual 

• Getting Started 

• Toolbar Icons 

• Trading 

• Account Detail & Alerts 

• Charting 

• Strategy Testing Tools 

• Market Data Tools 

• News & Messages 

• Stock Screener 

• Reference 

Quick Start Guide 

ABOUT THE USER MANUAL 

This Educational Guide and its content (including price and volume data, screen 
samples, and queries) are for informational and educational purposes only. 
Although it may provide general information relating to trading or investment 
approaches, you should not construe anything in the guide as legal, tax, and 
investment, financial or other advice. Nothing contained in the guide constitutes a 
solicitation, recommendation, promotion, endorsement, or offer by Schwab of any 
particular security, transaction, or investment strategy. 

Schwab makes no recommendations or endorsements with respect to any of the 
strategies, chart patterns, or indicators referenced; nor does Schwab recommend 
the use of technical analysis as a sole means of investment research. 

At Schwab, we recommend that investors define their goals, risk tolerance, time 
horizon, and investment objectives in addition to researching possible investment 
choices through multiple channels. Use of technical analysis may result in increased 
frequency of trading and, therefore, significantly higher transaction costs than a 
fundamental approach. 

CyberTrader, an affiliate of Charles Schwab & Co., Inc., provides technical services 
for StreetSmart Pro, a Schwab product. StreetSmart Pro is a registered trademark 
of Charles Schwab & Co., Inc. Schwab StreetSmart Pro is a pending trademark of 
Charles Schwab & Co., Inc. 

Access to Electronic Services and your account may be limited or unavailable during 
periods of peak demand, market volatility, systems upgrades or maintenance, or 
for other reasons. 
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Agreements 

Your Agreements With Schwab & Other Useful Information 

• CyberTrader®, an affiliate of Charles Schwab & Co., Inc., provides technical 
services for StreetSmart Pro®, a Schwab product.  

• Charles Schwab & Co., Inc. (member SIPC) and CyberTrader, Inc. (member 
SIPC/NASD) are independent subsidiaries of The Charles Schwab 
Corporation.  

• StreetSmart Pro® is offered at no charge to a select group of non-
professional Schwab Active Trader* clients who meet certain eligibility 
requirements based on trading frequency. This offer may be subject to 
additional restrictions and may be changed at any time.  

• The speed and performance of streaming functionality may vary depending 
on your modem speed, ISP connection and the number of securities you 
maintain on your Watch Lists. You need a Pentium 266 MHz or better 
processor, 128 MB RAM or more and a 56k or better modem, DSL or cable 
modem to receive the best possible experience of streaming quotes and 
news on StreetSmart Pro.  

StreetSmart Pro provides advanced market information for your desktop and allows 
you to place orders. It also allows you to connect and place trades through 
schwab.com. This User Manual explains how to use StreetSmart Pro’s trading 
capabilities and provides instructions on how StreetSmart Pro can be used with 
schwab.com. This manual is designed to give you easy-to-use, step-by-step 
instructions for using StreetSmart Pro.  

• Access to Level II data requires meeting certain eligibility requirements 
based on trading frequency. For additional information, please contact your 
Schwab Active Trader Team.  

• The market data used in this manual is for illustrative and educational 
purposes only, and is not intended to reflect actual trading behavior or other 
characteristics of any securities or company.  

• This manual was developed for use with StreetSmart Pro and should not be 
used for other trading software or channels.  

• You will receive an announcement about updates to the StreetSmart Pro 
software and User Manual the first time you Log Off StreetSmart Pro after 
the enhancements and upgrades become available. You may also receive 
updates through other methods, including electronic notification or emails.  

• Please remember that the real-time market data available through 
StreetSmart Pro may come from different sources than the real-time market 
data sources for Velocity, schwab.com, or other Schwab websites. This may 
result in slight differences in quotes and other information, especially in fast-
moving markets.  

Your use of each version of StreetSmart Pro is governed by your 
agreements with Schwab, including: 

• The End User License Agreement for StreetSmart Pro software that you must 
agree to as part of the software download process  

• Your account agreements, including the Electronic Services Agreement  
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• Any disclosures associated with the market data and trade order routing and 
functionality incorporated in or related to the use of the software, including 
the Direct Access Disclosure and Agreement 

The following information is not intended to replace your careful review 
and acceptance of the agreements and disclosures outlined above: 

• Before using StreetSmart Pro, you should carefully read all disclosures and 
instructions that Schwab provides for a complete understanding of 
StreetSmart Pro’s capabilities.  

• If you have a question about the StreetSmart Pro software that cannot be 
answered by the Help file or User Manual, contact your Schwab Active Trader 
Broker before taking any action.  

• Since StreetSmart Pro depends on third-party data feeds, lines, and systems, 
the accuracy and timeliness of market data cannot be guaranteed.  

• If data feeds, servers, and communication lines fail, Schwab is not 
responsible for these third-party components.  

• Alert your Schwab Active Trader Broker about any problems you encounter in 
using StreetSmart Pro, so we can help resolve them.  

• Schwab will continue to upgrade the StreetSmart Pro software and User 
Manual periodically. It is your responsibility to stay up-to-date with the most 
recent versions by downloading upgrades and enhancements when notified 
by Schwab.  

• In using this software, you are acknowledging that you understand and 
accept the risks involved in online trading.  

• By making StreetSmart Pro available to you, Schwab is not recommending, 
promoting or endorsing any particular investment, market data, or trading 
strategies.  
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Link to Customer Education 

Click on the Education Weblink icon  in the toolbar to access all of Schwab's 
educational material including: 

• Using StreetSmart Pro®  

• Market Education  

• Direct Access Trading  

• Printable User Manuals  

• Trader's Education On-Line Courses  

• Introduction to Stock Screener  
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CSUK and Hong Kong Customers 

Eligibility for and Use of StreetSmart Pro® Software and Other Related 
Products  

• CyberTrader®, an affiliate of Charles Schwab & Co., Inc., provides technical 
services for StreetSmart Pro, a Schwab product.  

• Charles Schwab & Co., Inc. (member SIPC) and CyberTrader, Inc. (member 
SIPC/NASD) are independent subsidiaries of The Charles Schwab 
Corporation.  

• StreetSmart Pro is offered at no charge to a select group of non-professional 
Charles Schwab Hong Kong and customers referred by Charles Schwab UK 
who meet certain eligibility requirements based on trading frequency. This 
offer may be subject to additional restrictions and may be changed at any 
time.  

• To learn more about specific eligibility standards for use of StreetSmart Pro 
by customers of Charles Schwab Hong Kong and customers referred by 
Charles Schwab UK, please contact your customer service representative.  

• For customers in Asia, UK, and Switzerland accessing StreetSmart Pro via 
DSL, ISDN or cable modem is strongly recommended in order to receive 
optimal speed and performance of streaming market data functionality  

• Certain products and services described in this Online Help guide may not be 
available to customers of Charles Schwab Hong Kong and customers referred 
by Charles Schwab UK, including but not limited to:  

o Access to schwab.com  

o Velocity Trading software  

o Schwab Platinum service and Schwab Platinum representatives  

o Direct Access trading via StreetSmart Pro  

o E-Mail Alerts and Trade Confirmations  

Your use of each version of StreetSmart Pro is governed by your 
agreements with Schwab, including:  

• The “End User License Agreement” and “StreetSmart Pro Disclosure and 
Agreement” that you must agree to as part of the software download process  

• Your account agreements, including the “Electronic Services Agreement”  

• Any disclosures associated with the market data and trade order routing and 
functionality incorporated in or related to the use of the software  

• Any laws or regulations in force in your country of residence pertaining to the 
download and use of encrypted software.  
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